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Job Cost 
Set Up Overview 
The diagram below identifies the typical process for this task. For the most current and detailed 
information, refer to Help. 
 

Setup Job 

 
Set up a job in Job Cost or by using Job Central. 

ä   

Setup Standard 
Cost Codes 

 
Set up standard cost codes in Job Cost. 

ä   

Setup Cost Codes 

 
Set up cost codes in Job Cost. 
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Workflow Overview 
The diagram below identifies the typical process for this task. For the most current and detailed 
information, refer to Help. 

 Note:  If you use the Project Management application with Job Cost, your workflow will differ from the 
one outlined here.  See the Help topics on Change Management in Project Management and Job Cost 
for direction. 

 

Enter Estimates 

 Record the estimate (budget or quote) for the job so costs can 
be tracked against it. 

ä   

Enter Contract 
Amount 

 Enter the contract amount or scheduled values through the 
miscellaneous worksheets.  If you use Contracts, this step is  
done in the Contracts application or in Job Central. Refer to the 
topics “Set Up a Job in Job Central” and “Enter Contract 
Amount” in this document. 

ä   

Enter Contract 
Change Orders 

 
Record changes and apply to estimate and contract amounts.   

ä   

Enter 
Commitments 

 Record purchase orders and subcontracts to facilitate cost 
control and prevent over-invoicing. 

ä   

Enter Commitment 
Change Orders 

 Make changes to issued commitments (purchase orders or 
subcontracts) using the Commitment Change Order command. 

ä   

Enter Direct Costs 

 Enter GL-only transactions or job costs not recorded through 
other applications such as Accounts Payable. 

ä  Continued on next page… 
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Enter Billings 

 If you do not use the Accounts Receivable application, use 
Enter Billings to bill jobs for payment or bill for retainage.  

ä   

Enter Cash Receipts 

 If you do not use the Accounts Receivable application, use this 
command to record payments made by owners for draws that 
you have requested. 

ä   

Post Entries 

 Post entries to update JC master file totals and send entries to 
General Ledger. 

ä   

Print Reports 

 
Produce management and reconciliation reports. 
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Set Up a Job in Job Central 
You can use Job Central to set up almost any type of job, with or without the Contracts application 
installed. A wizard guides you through the process, from entering the core job information to creating 
estimates, as well as setting up the contract. 

You should take the following into consideration when using Job Central to set up jobs. 

§ If using the Contracts application and you need to set up a contract for the job: 

• The job will be linked to a single contract which is created in Job Central. You cannot link the job 
to an existing contract ID. 

• All the contract items will use contract-based billing. Therefore do not use Job Central to set up 
jobs which use cost-based billing. 

• All the contract items will be linked to the same job. 

§ If using the Contracts application and but the job billing method is Quick Bill (that is, 

you do not need to set up a contract for the job), the contract amount can only be recorded at the job 
level. In other words, do not use Job Central to set up Quick Bill jobs which require billing at a level 
other than the job level. 

§ If the Accounts Receivable and Contracts applications are not installed, the billing level in Job Cost 
must be set to the job level in order to use Job Central. 

1. From Sage Timberline Office Desktop, select Job Central from the Tasks pane. 

2. Using the wizard, follow the steps to set up the job, define default job information, create the 
contract amount, create estimates, and set up the job structure. 

Set Up a Job in Job Cost 
The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Setting up a job” topic. 

1. From the Setup menu, select Jobs. 

2. Enter the job ID and description. This is the minimum information required on the General tab. 

3. Browse through the job items by clicking the various tabs. Enter the information applicable for the 
job being set up. If the Cost Account Retrieval method is By job or By hierarchy, you should enter 
the expense or WIP account number in the Cost Account item on the AP and GL tab. Also, if you 
retrieve prefixes from the job, the GL account prefix is required. 

  

 Warning: The default billing method for new jobs is specified in the Default Billing Settings window at 
File > Company Folder Settings > JC Settings > Billing. When you create a new job in the Job Setup 
window, verify that the billing method on the Billing Info tab is correct. After you save a new job for 
the first time, the billing method cannot be easily changed. 
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4. Click [Save] when you have completed entries for this job. 

5. Repeat steps 2 – 4 for each job being set up, then click [Close]. 
  
 Note: You can also quick-add a job while making entries, but you will not be able to access all items 

that are available through Setup > Jobs. 

Set Up Standard Cost Codes 
The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Setting up a standard cost code” topic. 

1. From the Setup menu, select Standard Cost Codes. 

2. Enter the Standard Cost Code ID and its Description. This is the minimum information required. 

3. Complete the items in the window as applicable. If categories are not being used, be sure to select 
the appropriate Accumulate as (cost type) option. 

4. Click [Save] when you have completed items. 

5. Repeat steps 2 – 4 for each standard cost code being set up, then click [Close]. 
  
 Note: When you change information in a standard cost code that already exists, only new cost code 

records will contain the new information. Cost codes that are already attached to jobs do not change. 

Set Up a Cost Code 
The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Setting up a cost code” topic. 

1. From the Setup menu, select Cost Codes. 

2. Enter the job ID, extra ID (if applicable), cost code ID, and description. This is the minimum 
information required. If you use group cost codes, you cannot set up an individual cost code until 
there is a standard cost code for the group. 

  
 Note: When the cursor is in the Cost Code field you can click [List] to view and select from existing or 

standard cost codes. If you set the cost account retrieval method to By cost code or By Hierarchy, you 
should enter the expense or WIP account number in the Cost account field on the General tab. 

3. Browse through the cost code items by clicking various tabs. Enter the information applicable for the 
cost code being set up. 

4. Click [Save] when you have completed entries for this cost code. 

5. Repeat steps 2 – 4 for each cost code being set up; then click [Close]. 
  
 Note: You can also quick-add a cost code when you make entries, but you will not be able to access all 

items that are available through Setup > Cost Codes. 
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Enter Estimates 
Estimates provide a basis for cost comparisons, cost control, and cost projection. Use Tasks > Enter 
Estimates to enter your job estimates. If you create your job in Job Central, you can also enter your 
estimates within that task. 

Estimates are entered at the category level. Because estimates are not actual costs, no General Ledger 
entries are created. 

If you use Timberline Estimating or another estimating software package, use Import Estimates to 
create entries. 

The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Entering estimates” topic. 

1. Manually itemize the estimated costs by job, cost code, and category. 

2. From the Tasks menu, select Enter Estimates. 

3. Enter each estimate into the grid. If the estimate is final, click [Finalize Original Estimate]. 

 If you use group cost codes, for example, 03-000, you can enter estimates to only the individual cost 
codes within a group. When the entries are posted, the group cost code totals are updated. 

4. Click [Totals] to verify totals by cost type. 

5. Click [Category Totals] to verify totals by category; then click [Close] to return to the grid. 

6. Click [Finish] if you have made all the necessary entries. Otherwise, return to step 3. 

7. Change the options displayed in the Print Selection window or accept the defaults. 

8. Click [Start]. 

9. Review the Estimates Journal to verify totals and to check for errors. The Estimates Journal is 
generated automatically. 
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Enter Contract Amount  
 Note: If the Contracts application is installed and the billing method is Use Contracts, you can enter 

contract amounts and scheduled values in Contracts or in Job Central. Refer to the topic “Set Up a Job 
in Job Central” in this document. 

The list below identifies the typical steps and reports for this task. If you set up the job in Job Central, 
you can also enter the contract amount in that task.  For the most current and detailed information, 
refer to Help, specifically the “Entering contract amounts, production units, and miscellaneous 
information” topic. 

1. From the Tasks menu, select Enter Misc. Worksheets. 

2. Enter the view to use. Click [List] to display available views and their descriptions. 

3. Enter the ID for the job whose entries are to be made and the report date. 

4. Move the cursor to each cost code that you have an entry for and enter the information in the 
appropriate columns. If the cost code does not appear in the grid, click [Go to Cost Code] to jump to 
the appropriate line. 

5. To enter information for a category, select the category line item and enter the information. If the 
category does not appear in the grid, click [Go to Category] to jump to the applicable line. To return 
to the cost code entries, click [Cost Code View]. 

6. To enter information applicable for only the job, click [Job]. Enter the information and click [OK]. 

7. If there is an extra ID displayed on the line and the information is applicable to only the extra, click 
[Extra], enter the information, and click [OK]. 

8. When you are done with this job and its sublevels, click [Save]. 

9. Repeat steps 3-8 for each job to be entered. 

 You can enter a job only once in each session. If you have two cumulative amounts to enter for a 
particular line, add the amounts together and enter the total. 

10. Click [Finish]. 

11. Change the options displayed in the Print Selection window or accept the defaults. 

12. Review the Misc. Worksheet journal to verify totals and to check for errors. The Misc. Worksheet 
journal is generated automatically. 
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Enter Contract Change Order 
Use Tasks > Change Orders to make changes to original contract amounts (or scheduled values), original 
estimates, estimated units and costs, and estimated production units for jobs.  

If you use Project Management to manage your jobs, all job change orders and commitment change 
orders should be handled through Project Management so you can take advantage of the enhanced 
features. If you do not use Project Management but use Accounts Receivable and Contracts, you can 
also enter contract change orders for contract-based jobs in Contracts. Refer to Help, specifically the 
“Entering change orders in Job Cost or Project Management (when interfacing with Contracts)” topic. 

The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Entering change orders in Job Cost or Project Management 
topic.   

1. From the Tasks menu, select Change Orders. 

2. Enter the ID of the job to be changed. If the change is for an extra, also enter that ID. 

3. Enter the change order ID, description, and date. 

4. If the change order is internal, under Type select Internal. 

5. Enter an appropriate description in the Scope of Change field. 

6. Click [Other Info] if you have additional miscellaneous information to add. 

7. Select the Release to Accounting check box, if appropriate, to make the change order available for 
approval and to accounting. 

8. Click [Enter Items] to enter the change order detail. 

9. Click [Save] to accept the change order. You cannot re-access a change order after you click [Save] in 
the current session. 

10. Repeat steps 2–9 until all change orders have been entered; then click [Finish]. 

11. Change the options displayed in the Print Selection window or accept defaults.  

12. Click [Start]. 

13. Review the Change Order Journal to ensure that everything was entered correctly. The Change Order 
journal is generated automatically. 
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Enter Commitments  
To track purchase orders and subcontracts your first step is to enter commitments. Commitments 
enhance job cost reports by providing committed cost information before you receive invoices.  

You can also use the Enter Commitments task to print purchase order and subcontract documents for 
your vendors. 

When you enter commitments, warnings are given when costs exceed the estimate. This allows for 
more effective project management. 

The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Entering commitments” topic. 

1. Gather the required commitment information: vendor, job, PO or subcontract ID, cost code, 
category, tax group, amount, date, and other related information such as terms, ship date, etc. 

2. From the Tasks menu, select Commitments. 

3. Enter the new or original commitment ID. 

4. Complete the descriptive information about the commitment. 

5. Enter each detail line of the commitment. 

6. Verify the amount in the Total area at the lower left of the window. 

7. Select the Release to Accounting check box, if it is appropriate and you are authorized to do so. 

8. Click [Save Commitment]. 

9. If the commitment has not been committed and you have the authority to do so, you will be asked, 
“Commit?” Click [Yes] or [No]. 

10. Repeat steps 3-8 until all commitments have been entered. Then click [Finish]. 

11. Change the options displayed in the Print Selection window or accept the defaults. 

12. Click [Start]. 

13. Review the Commitment Journal to verify totals and check for errors. The Commitment journal is 
generated automatically 

14. Review the accuracy of any commitment documents that may have printed. 
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Enter Commitment Change Orders  
Use the Commitment Change Order command to adjust units and amounts on commitments.  You can 
add new commitment items or add approved changes to existing items on a commitment.  If you use 
Project Management to manage your jobs, all job change orders and commitment change orders should 
be handled through Project Management so you can take advantage of the enhanced features. If you do 
not use Project Management but use Accounts Receivable and Contracts, you can also enter contract 
change orders for contract-based jobs in Contracts..The list below identifies the typical steps and reports 
for this task. For the most current and detailed information, refer to Help, specifically the “Entering 
commitment change orders” topic. 

 Note: You may not enter a commitment change order for a commitment that applies to any job that 
you are not authorized to access.   

1. Gather the required commitment change order information: PO or subcontract ID, job, cost code, 
category, amount, date, and other related information such as scope details, date notice to proceed 
was given, etc. 

2. From the Tasks menu, select Commitment COs. 

3. Enter the original commitment ID. 

4. Enter the new or original commitment CO ID. 

5. Enter the rest of the descriptive information for the commitment change order. Use the What’s This? 
Help feature to display brief information about the various buttons and items in the windows. 

6. If the commitment change order is associated with a job, enter the job, extra (if applicable), cost 
code, and category IDs in their respective line item grid columns. You cannot override an original line 
item except in the description field. 

7. If this is a change order for a unit-price commitment, enter the Units For This Change. Then, if the 
line is a new line, enter the Unit Cost. (If the line already existed, you cannot change the Unit Cost.) 
After you save a commitment change order, you cannot change this Unit Cost. 

8. To calculate tax for this line item, enter the Tax Group. 

9. Enter or accept the calculated change order amount, which includes tax, in the Cost For This Change 
column. You can enter a negative amount if you intend to reduce the total commitment. 

10. Once a commitment change order is approved, only limited information can be edited.  To change 
amounts or job costing information, another commitment change order can be entered. 

11. If the commitment change order is associated with a change order, you can optionally click [Change 
Order Link] and enter the job, extra, and change order number in the Enter Change Order Link 
window. 

12. Verify the total at the lower right of the window. 
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13. Select the Release to Accounting check box if appropriate and you have the authority to do so. 

14. Click [Save Commitment CO]. 

15. Repeat steps 3-13 until all commitment change orders are entered. Then click [Finish]. 

16. Change the options displayed in the Print Selection window or accept the defaults. 

17. Click [Start]. 

18. Review the Commitment CO Journal to verify totals and to check for errors. The Commitment CO 
journal is generated automatically. 

Enter Direct Costs  
Accounts Payable, Payroll, and Equipment Cost generate most Job Cost expenses. Occasionally you may 
need to record the cost for some items that are unrelated to Accounts Payable, Payroll, or Equipment 
Cost, such as allocation of inventory. Use the Enter Direct Costs task to record costs to a job and 
generate corresponding General Ledger entries. 

The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Entering direct costs” topic. 

1. From the Tasks menu, select Enter Direct Costs. 

2. If the entry is for General Ledger only, click [GL Only]. If the entry pertains to a job and you just 
entered a general ledger-only entry, click [JC Entries]. 

3. Enter the cost into the grid. 

 If you use group cost codes (e.g., 03-000), you can enter direct costs to only the individual cost codes 
within a group. When the entries are posted, the group cost code totals are updated. 

4. Repeat steps 2 and 3 for each entry. 

5. Click [Totals] to verify totals. 

 If the interface to General Ledger is activated, the debit and credit totals must equal, unless you 
select No under Force Zero Proof in GL: File > Data Folder Settings > GL Settings > [Processing 
Options]. 

6. Click [Category Totals] to verify totals by category; then click [Close] to return to the grid. 

7. Click [Finish] if all entries have been made. Otherwise, return to step 2. 

8. Change the options displayed in the Print Selection window or accept the defaults. 

9. Click [Start]. 
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10. Review the Direct Costs Journal to verify totals and to check for errors. The Direct Costs journal is 
generated automatically. 

Enter Billings 
Use this command to bill jobs for which you are requesting payments, or to bill retainage held from 
previous billings. This command provides a direct entry method to associate customer billings with jobs. 
Amounts billed are normally associated with a specific draw request. Accounts Receivables and other 
third-party software can also create billings that can be imported with the Import > Receivables 
command. 

This command is not available if you have Accounts Receivable and an Accounts Receivable Master File 
is present for the company being processed. 

The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Entering billings” topic. 

1. Gather the required billing information such as draw ID and job-related IDs. 

2. From the Tasks menu, select Enter Billings. 

3. Enter each billing into the grid. In the grid columns preceding the Amount column, enter the 
information applicable to the billing. 

4. If you are doing progress billing, you can click [Calc Billing] when the cursor is in the Amount Billed 
column. This opens the Calculate Billing Worksheet window to help you determine the billing. Use 
the What’s This? Help to determine how to enter appropriate amounts for the available items. 

5. In the Retainage column, enter the amount of retainage you want to withhold from the full amount 
of the billing. If you are withholding retainage and billing previously withheld retainige, enter the 
difference between the two. For example, if you want to withhold 1,000.00 and bill for 1,200.00, 
enter 200.00. 

6. An H will appear in the next column to the right if you are withholding the amount, or a B will appear 
to show that you are billing for net retainage. For the example in step 5, a B would appear in the 
column. Click [Hold Retainage] and [Bill Retainage] to alternate between the H and the B. 

7. Complete the rest of the grid line. 

8. Repeat steps 3 through 7 for each billing transaction. 

9. When you are finished, click [Totals] to verify your totals. Click [Close] to return to the grid. 

10. Click [Finish]. 

11. Click [Start]. 

12. Review the Billings journal to verify the totals and check for errors. 
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Enter Cash Receipts 
Use this command to record payments made by owners for draws that you have requested. Cash 
receipts can be entered regardless of whether a draw exists. 

Accounts Receivable and other third-party software can also create payments that can be imported with 
the Import, Accounts Receivable command from the Tools menu. 

This command is not available if you have installed Accounts Receivable and an Accounts Receivable 
Master file has been created for the company being processed. 

The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Entering cash receipts” topic. 

1. From the Tasks menu, select Enter Cash Receipts. 

2. Enter the deposit information and click [OK]. 

3. Enter each payment into the grid. If the payment is for an existing draw, the invoice number prefills 
and you cannot change it. If the payment is for a new draw, you cannot enter an invoice number. 

4. Click [Totals] to verify the total deposit amount entered; then click [Close] to return to the grid. 

5. Click [Finish]. 

6. Click [Start]. 

7. Review the Cash Receipts Journal to verify totals and to check for errors. 
  
 Note: See the Job Cost Help topic “Entering Cash Receipts” for information about entries created and 

automatically posted in Cash Management. 

Post Entries 
In order for your reports to be a reliable tool for use when you need to make decisions, you must 
maintain accurate totals. Posting is the means by which job totals are updated. 

The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Posting entries” topic. 

1. Back up your data files. 

2. From the Tasks menu, select Post Entries. 

3. Click [Ranges] to limit the batches that post. 

4. Click [Printer Setup] and select a printer or print file name. 

5. Click [Start] to begin processing. 

6. Print and review the Post Entries Report. The Post Entries report is generated automatically. 
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Print Reports 
The list below identifies the typical steps and reports for this task. For the most current and detailed 
information, refer to Help, specifically the “Printing reports” topic. 

1. From the Reports menu, select the desired report: 

• Reports > Change Order Log 

• Reports > JC Profit 

• Reports > Job Cost Report 

• Reports > Committed Cost Status 

• Reports > GL Reconciliation 

2. If the Data File Selection window opens, select the desired file type (master, invoice, etc.). 

3. Complete the required prompt fields, such as Report date displayed at the top of the window. 

4. Make other print selections as needed. 

5. Click [Start] to begin processing and printing the report. 

 

 

 

 

 

 

 

 

 

 

 

  

 


